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What is Mass Profiler?
Agilent MassHunter Mass Profiler software is a stand-alone program 
specifically designed to investigate features in your LC/MS and GC/MS sample 
data files and compare feature similarities and differences in your data 
between two samples, within a single sample group, or between two samples 
groups. The feature investigation capabilities are well suited for the 
comparison of two samples from different environmental locations (for 
example, two locations in a river or a ground water well) and different batches 
in a food or chemical synthesis process. Mass Profiler can also be used for 
expression profiling applications such as biomarker discovery. Mass Profiler 
uses a unique feature extraction and correlation algorithm that locates and 
aligns all the components in even the most complex sample mixtures. 



What is Mass Profiler?
Mass Profiler helps you:

• Find and extract the molecular features in your sample data.

• Align and normalize features from different samples.

• Review the features in your samples individually and by grouping.

• Investigate statistically meaningful similarities and differences in 
features across two samples, a single sample, or two sample groups.

• Conduct a sample classification in pairs using Principal Component 
Analysis. 

• Identify features via a molecular formula generator or accurate mass 
database search using MassHunter ID Browser.

• Perform data analysis using various workflows including metabolomics, 
integrated biology, pharmaceutical impurity analysis, forensic analysis, 
environmental analysis, and pesticide analysis.

Mass Profiler operates on MassHunter LC/MS and GC/MS data files, including 
raw data acquired from LC/IM-MS instruments, EI-GC/MS data files acquired 
in both accurate and unit mass modes, and compound exchange files produced 
by MassHunter Qualitative Analysis and Profinder. Retention time, mass, and 
abundance LC/MS data can also be imported from any source using comma 
separated value files.

Feature extraction, combined with alignment across multiple data files using 
m/z, retention time, and drift time (LC/IM-MS data), is a critical step in 
differential analysis workflows exhibiting minimal false positive or negative 
feature differences between samples or sample groups.

Features can be exported by Mass Profiler for statistical data analysis by Mass 
Profiler Professional (MPP), a powerful chemometrics platform used in any 
MS-based differential analysis to determine relationships among two or more 
sample groups and variables. The profile data may also be exported for data 
analysis by other database search programs, identification environments, or 
statistical analysis packages.
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What’s new in B.08.00?
What’s new in B.08.00?
• An option is available in displaying results to display only the features that 

have been identified or to display all of the features.

• Features can be exported to a CEF file.

• Select whether or not to report any single-ion feature with a charge state of 
one (1). This is especially useful for small molecule features.

• Specify a minimum number of charges for identified features. This is 
especially useful for peptide features.

• Support is added for EI-mode GC/MS data files: TOF (.d), quadrupole 
profile and unit mass (.d), and AMDIS (.cef).

• Quality scores for the LC/IM-MS feature extraction algorithm (IMFE - 
retention time, drift time, m/z, and abundance) are now calibrated with 
those generated by LC/MS molecular feature extraction algorithm (MFE - 
retention time, m/z, and abundance).

• Improved performance of the IMFE groups all isotopes from a single 
species, typically (M+H)+, into one feature, but does not group differently 
adducted species into one compound, such as (M+H)+, (M+NH4)+, (M+2H)2+ 
and (2M+H)+, since they are typically separated by the ion mobility stage.

• Drift times and CCS values, when available, are exported with features 
found using IMFE.

• Export a CEF file for each individual sample when you are processing ion 
mobility data (average mass, RT, DT, and CCS).

• Export feature summary includes data columns that contain the abundance 
of the feature in each of the samples.

• Select a feature in the Feature Table by directly selecting the feature 
appearance in the Feature Plot.

• Mass Profiler installs and uses ID Browser B.08.00.
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Functionality of Mass Profiler
Functionality of Mass Profiler
• Locate and extract the molecular features in your data files, not just 

chromatographic peaks. 

Note: When you process IM-MS data, features based on isotopic ion clusters 
are located and extracted instead of molecular features. IM-MS data is 
processed using isotopic clusters because differently adducted molecular 
ions may have different ion mobility drift times.

• Visualize statistically meaningful differences between two sample groups, 
such as healthy versus disease samples.

• Calculate abundance ratios and clearly identify differentially expressed 
features.

• Quantify a compound by maximum ion intensity (height), maximum ion 
volume, or feature volume.

• Analyze and compare your data using flexible feature selection.

• Export compound information for import into database search programs, 
identification environments, non-MassHunter statistical analysis packages, 
and advanced statistical data analysis by Mass Profiler Professional 
software.

• Perform data analysis using various workflows such as metabolomics, 
integrated biology, pharmaceutical impurity analysis, forensic analysis, 
environmental analysis, and pesticide analysis.

• Open all or some of the files associated with your Agilent data set (sample 
files) in a single selection process.

• Create methods for your feature extraction, alignment, and differential 
analysis, and save them to disk as a Mass Profiler Method file (.mpm).

• Review your features and alignment using an intuitive graphical interface.

• Filter and curate your differential analysis results.

• Save your feature extraction and feature review progress as a Mass Profiler 
project file (.pjt) and open the project at a later time to review, adjust, and 
reprocess your data files.
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Where is Mass Profiler used in your experiment?
Where is Mass Profiler used in your experiment?
Mass Profiler is used to extract and/or review the features from LC/MS data 
files you acquired from your experimental samples. As part of an untargeted 
differential analysis experiment, Mass Profiler may be employed in steps 3, 4, 
and 5:

1 Prepare for your experiment.

2 Acquire your data using Data Acquisition.

3 Extract spectral features in your data files using Profinder or 
Mass Profiler.

4 Compare two samples or sample groups using Mass Profiler.

5 Identify features in your data using ID Browser with Mass Profiler.

6 Export features for advanced statistical analysis using MPP.

7 Save your project using Mass Profiler and MPP.

Figure 1 Workflow for a differential analysis

Figure 1 shows the steps and MassHunter tools that are used in an untargeted 
and targeted differential analysis. The feature finding steps performed by 
Mass Profiler can alternatively be accomplished in Profinder (TOF and Q-TOF 
data) as described in the Class Prediction with Agilent Mass Profiler 
Professional - Workflow Guide. 
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Where to find more information
Mass Profiler provides easy to use data analysis capabilities to help you review 
features, compare features between two samples or sample groups, and 
perform a principal component analysis with your samples organized into two 
groups. Compared to Mass Profiler Professional, Mass Profiler is unique in 
that you can view compound chromatograms or drift spectra and mass spectra 
during your analysis.

Feature extraction performed by the feature extraction and finding algorithm 
in Mass Profiler is similar to the feature extraction and finding algorithm in 
MassHunter Qualitative Analysis and Profinder; however, Mass Profiler and 
Profinder add the functionality of recursive grouping across multiple data 
files which improves isotopic grouping and minimizes false positive and false 
negative differences.

Where to find more information

Online Help

Press F1 To get more information about a pane, window, or dialog box, place 
the cursor on the pane, window, or dialog box of interest and press F1.

Help Menu Click Help > Contents to access the contents of the Mass Profiler 
online Help including basic tasks, user interface, and reference information.

Resource App
Install the Mass Profiler Resource App from the Mass Profiler installation 
guide. This Resource App gives you access to the Mass Profiler Quick Start 
Guide (this guide) and the Mass Profiler Familiarization Guide.

Install the MPP Resource App from the Mass Profiler Professional 
Supplemental Disc. The MPP Resource App gives you access to the Mass 
Profiler Professional documents and Workflow Guides described in this guide, 
as well as interactive training guides for Mass Profiler Professional
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Where to find more information
Documents

Mass Profiler Familiarization Guide Use this guide to learn 
how to use Mass Profiler. This guide can be found in the 
Mass Profiler Resource App and also online at 
http://www.agilent.com/cs/library/usermanuals/public/G32
97-90018_MassProfiler_Familiarization.pdf.

Mass Profiler Professional 
• Agilent G3835AA MassHunter Mass Profiler Professional Software - Quick 

Start Guide

• Agilent G3835AA MassHunter Mass Profiler Professional Software - 
Familiarization Guide

• Agilent G3835AA MassHunter Mass Profiler Professional Software - 
Application Guide

• Agilent MassHunter Mass Profiler Professional User Manual

Workflow Guides and Overviews 
• Agilent Metabolomics Workflow - Discovery Workflow Guide / Overview

• Integrated Biology with Agilent Mass Profiler Professional - Workflow 
Guide / Overview

• Class Prediction with Agilent Mass Profiler Professional - Workflow Guide / 
Overview

• Agilent Lipidomics Workflow Guide / Overview

Training

Road Show Slide Presentation Metabolome Analysis - From Sample Prep 
Through Data Analysis (Metabolomics Road Show, March 2011)

Training Courses  Visit www.agilent.com to view a listing of training courses 
for Mass Profiler.
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Getting Started
How do I get started?
Getting Started

How do I get started?
This Quick Start Guide helps you install Mass Profiler, become familiar with 
the Mass Profiler user interface, perform feature extraction, and perform a 
two sample or two sample group comparison using your data.

1 Install Mass Profiler. Follow the instructions in “Mass Profiler Installation” 
on page 50.

2 Start Mass Profiler. Double-click the Mass Profinder icon  located on 
your desktop or in the Agilent MassHunter Workstation desktop folder, or 
click Start > All Programs > Agilent > MassHunter Workstation > Mass 
Profiler > Mass Profiler.

3 Review this Quick Start Guide to learn about:

• Getting Started

• User Interface

4 Review the Familiarization Guide to learn how to:

• Process Data

• View Results

• Identify Features

• Export Data

5 Review the “Workflow Guides and Overviews” guides (see “Documents” on 
page 7). These guides help you improve your results by covering topics that 
help you:

• Prepare for an experiment

• Explain the parameters related to finding features

• Compare samples among the groups in your experiment

6 Review the exercises in the Familiarization Guide to learn how to extract 
and analyze the features in your samples. An example “Basic Mass Profiler 
Workflow” is illustrated in “Exercise B: 2-Sample-Group-Comparison”.
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Getting Started
Terminology
Terminology
Algorithm An algorithm is a set of automated, sequential mathematical tasks performed 

to find, filter, align, extract, compare, and identify features from your 
chromatographic/mass spectral data sets.

Feature A feature is synonymous with compound. A feature is referred to 
interchangeably with compound, descriptor, element, entity, metabolite, or 
molecular feature during the various steps of analysis using MassHunter 
software. A feature can consist of one or multiple related ions, including 
isotopes, and different ion species (charge carrier, multimers) and charge 
states. For LC/IM-MS data, ions representing different ion species and charge 
state are not combined because these ions are typically separated by drift time 
in the ion mobility stage.

Group Samples that have a common relationship within the definition of the 
experiment design, for example, samples from a group of healthy versus 
diseased specimen. Related samples are grouped together for analysis. For a 
project with two groups, Mass Profiler initially assigns “Experiment” and 
“Control” for the group names. Because the these default names can be 
changed this guide may refer to the Experiment group as <Group 1> and the 
Control group as <Group 2>.

IMFE Refers to the algorithm that operates on LC/IM-MS data to group all of the 
isotopes from the same adducted neutral molecule into a single, reported 
feature. IMFE is short for IM-MS feature extractor or IM-MS feature extraction.

Method A method is a set of all the parameters used for processing sample files in a 
Mass Profiler project, including feature finding, aligning, normalizing, and 
filtering. Methods can be saved using unique file names.

MFE Refers to the algorithm that operates on GC/MS and LC/MS data to group all 
of the isotopes from all of the ion species derived from the same neutral 
molecule into a single, reported composite compound. MFE is short for 
molecular feature extractor or molecular feature extraction.

Project Two samples, or one or two sample groups, and the associated method that 
form your feature analysis and investigation. A project can be saved and 
opened at a later time to continue your analysis.

See “Open Project” on page 20 for important information regarding opening 
project files on different computers.
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Getting Started
Terminology
Sample GC/MS and LC/MS data acquired from a specimen and understood to be 
representative of the larger specimen or population. Individual samples are 
imported into Mass Profiler in the form of raw data files, CEF files, or CSV 
files (see Figure 1 on page 5).

Workflow A workflow is a sequence of steps executed for an analytical task, the type and 
sequence of which can be documented via a graphical overview. A workflow 
may cover more than one wizard and may include steps performed by more 
than one MassHunter software program.

Feature extraction using MFE and IMFE

MFE is a composite compound feature finder applied to non-IM LC/MS data. 
MFE feature finding and extraction parameters are retention time, m/z, and 
abundance. MFE creates a single composite compound from all of the isotopes 
of all of the differently adducted molecular ion species, such as (M+H)+, 
(M+NH4)+, (M+2H)2+ and (2M+H)+. Differently adducted molecular ions are 
combined into one feature.

IMFE is an ion cluster feature finder applied to find the features in LC/IM-MS 
data. IMFE feature finding and extraction parameters are retention time, ion 
mobility drift time, m/z, and abundance. IMFE finds features based on ion 
clusters and groups only the isotopes from a single adducted species. IM-MS 
data is processed using isotopic clusters because differently adducted 
molecular ions may have different ion mobility drift times.

The feature finding and extraction algorithm treats all of the mass spectral 
data from the experiment as a large array of values and removes from that 
array any values that correspond to persistent or slowly-changing background. 
Then the algorithm searches for ions that have a common elution and drift 
profile (for example, for m/z values whose abundances reach a local maximum 
at very nearly the same retention and drift times). Ions are then grouped into 
one or more features containing related mass or m/z values to form a 
composite compound or an ion cluster.

Unlike MFE which creates a single composite compound from all of the 
isotopes of all of the differently adducted molecular ion species, IMFE finds 
features based on ion clusters and groups only the isotopes from a single 
adducted species into one feature. Since differently adducted ions of the 
molecular ion may have different drift times, IMFE does not group different 
ions from differently adducted species into a single composite compound, 
such as (M+H)+, (M+NH4)+, (M+2H)2+ and (2M+H)+. The selection of the charge 
state carriers has been disabled when using IMFE.
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Getting Started
Processing and viewing results
Processing and viewing results
The results of processing samples appear in the Feature Table, Feature Plot 
and Feature Details in the main window. In the main window you select 
whether to show the Feature Plot or the Feature Details to appear with the 
Feature Table in the main window (see Figure 3 on page 14 and Figure 4 on 
page 15).

Use the Feature 
Table to:

• View all of the feature information for two samples or larger sample sets 
represented statistically across one or two groups.

• View feature information in four sections showing information across all 
samples, each of the two sample groups, and comparison of two sample 
groups.

• Mark and unmark features for identification and PCA analysis.

See “Feature Table” on page 33 for more information.

Use the Feature 
Plot to:

• Visualize and investigate features using different plot types, for example: 
Abundance comparison, Mass difference, RT difference, Abundance vs. 
mass, Abundance vs. RT, Mass vs. RT. 

• Investigate all features, features unique to the Experiment group
(<Group 1>), or features unique to the Control group (<Group 2>).

• Investigate features in an individual sample, all samples, or compared to 
each group.

• Investigate features that are above and below a specified highlighting 
threshold filter setting.

• Investigate features by abundance, mass, drift time, and retention time 
across all samples using color to distinguish individual features or to 
identify features by sample or group.

See “Feature Plot” on page 37 for more information.

Use the Feature 
Details to:

• Visualize and investigate specific individual feature details such as 
appearance in each sample file, appearance in each group, and the ion 
species within the feature.

• Compare the feature’s appearance across all of the samples.

• Investigate features by retention time, drift time, mass, and m/z using 
extracted ion chromatograms and mass spectra for all of the samples.

See “Feature Details” on page 41 for more information.
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Getting Started
Identification
Identification
Mass Profiler (Figure 2) works with MassHunter ID Browser to help you 
identify features via molecular formula generation or an accurate mass 
database search using a personal compound database (.cdb or .csv formats). 
Features can be identified individually or in a batch. Additional mass-based 
identification methods are supported using publicly available database 
searches. Spectral library search is not supported in ID Browser for LC/MS 
data.

Figure 2 ID Browser after identifying features as compounds
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Getting Started
Exporting data
Exporting data
Features found and aligned across samples can be exported in several formats 
for different purposes. You can export features in the following formats:

• .cef - Export file format that contains a list of the found features in each 
sample with the algorithm used to find the features, and includes MS ions 
(only precursor ions) with mass, abundance, RT, charge state, and charge 
carrier. A compound exchange format (CEF) file is created to exchange data 
between Agilent software. CEF files are typically used for import into MPP 
for advanced statistical analysis.

• .csv - Averaged ion data (m/z and RT of representative ions) for each feature 
for use in data acquisition in targeted MS/MS experiments. An ASCII text 
comma separated value (CSV) file is created containing specific feature 
information that can be readily imported into acquisition software as an 
MS/MS inclusion list or imported into text editors and spreadsheets.

• .txt - Feature data for use in Mass Profiler Professional. A tab delimited 
ASCII text (TXT) file is created containing the feature information for each 
sample data file that is readily imported into MPP, other data analysis 
software, text editors, and spreadsheets.

• .xls - Feature Summary data for use in Excel. This format is the same tab 
delimited ASCII text file as the .txt format, but the .xls extension allows the 
data to be readily imported into Microsoft Excel. The file can also be 
imported into text editors.
Mass Profiler Quick Start Guide 13



User Interface
Main functional areas
User Interface

Main functional areas
The main Mass Profiler window consists of three parts: (1) Menu Bar, (2) 
Toolbar, and (3) Main Window. The main functional areas are shown in 
Figure 3.

Figure 3 The main functional areas of Mass Profiler after a method is run on a project. If selected in the View 
menu, the Feature Plot can be replaced with a Features Details view shown in Figure 4 on page 15.
14 Mass Profiler Quick Start Guide



User Interface
Main functional areas
Menu Bar

The menu bar provides actions that are used for managing your projects, 
methods, display, and identifying features.

[

Toolbar
The toolbar is located below the menu bar and contains three groups of 
buttons for commonly used tasks: 

[

Main Window

The main window, see Figure 3 on page 14, is further divided into two areas, 
the Feature Table and the Feature Plot, that are used to review the results 
from applying the feature extraction, alignment, filtering, and comparison 
defined in the method to your data set.

Figure 4 When you click View > Switch to Feature-Details Mode, the Feature Details pane (above) replaces 
the Feature Plot pane in the main window shown in Figure 3 on page 14.
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User Interface
Main functional areas
Feature Table The data presented in Feature Table is organized into sections: 
(1) Feature Summary, (2) Experiment Group Information, (3) Control Group 
Information, and (4) Group Comparison Information as shown in Figure 5. 
Each feature is presented in a row and the feature information is presented in 
columns. The number of samples in each group is shown in the table heading 
and is the maximum frequency possible for a feature in the respective group.

Feature information is presented as the average across all of the samples in a 
single group project. When your project contains two groups the Feature 
Summary columns report the average mass and RT, but the higher (averaged) 
abundance and Q-Score across both groups, as well as standard deviations and 
relative standard deviations. One column indicates if there was saturation in 
the compound spectrum, and another column allows you to mark features for 
additional tasks such as identification, PCA calculation, and exporting. The 
columns in the Group Comparison section report the mass, RT, and DT 
differences between the experiment groups, the intensity ratio, up- or 
down-regulation, and differential score.

When you right-click the row number within the Feature Table, you have 
additional commands to review and identify the individual feature. 

Abundance Distribution is available when you have a 2-group project and 
at least one group has two or more samples.

Figure 5 Data areas within the Feature Table Pane
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User Interface
Main functional areas
View Feature in IM-MS Browser is available when you have ion mobility 
data and when the total number of samples (regardless their grouping) is 
one or two. When you have more than two ion mobility samples in your 
project, you can launch IM-MS Browser from Feature Details pane for each 
individual sample.

Feature Plot One of the plots presented in the Feature Plot is organized as a 
set of graphical information data that helps you view the distribution of the 
features in mass versus retention time (RT) as shown in Figure 6. The relative 
size of the marker representing a feature is an indication of the average 
abundance of the feature.

The two additional graphs designed to compare abundance ratios between 
groups are not informative with a single group project. However, when your 
project contains two groups, the additional graphs help you visualize the 
abundance ratios with respect to retention time and mass and help you 
visualize the features with respect to group membership.

Figure 6 Views available within the Feature Plot pane for LC/MS and LC/IM-MS data
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User Interface
Main functional areas
When you click within the Feature Plot, you can zoom in on the axes to see 
more of the feature detail.

When you right-click within a Feature Plot, you have additional commands to 
unzoom, review and identify the feature, and print, copy and save the 
graphical information. When you right-click along the axes or border of a 
Feature Plot, you have commands to unzoom, print, copy and save the 
graphical information.

When you move the pointer over a feature in the plot, a data window shows 
details about the feature, including mass, RT, DT (for LC/IM-MS), and 
abundance, including absolute and RSD values across a group.

Feature Details The data presented in Feature Details is organized in four 
panes: (1) Feature Details by Sample - a table of the feature appearance in 
each sample data file, (2) Feature Details by Ion, (3) Extracted Ion 
Chromatogram (Figure 7 on page 19) or Drift Spectra (Figure 8 on page 19) 
graphics, and (4) Average Mass Spectrum graphics. EIC’s can be summed for 
all ions or created from individual ions. The chromatogram and spectrum 
graphics are available if the method was run on raw data files.
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User Interface
Main functional areas
Information available in the Feature Details is limited for file types other than 
raw data files. For CEF files extracted ion chromatograms are not available. 
For CSV files Feature Details are not available.

When you double-click any row number, the information displayed updates to 
reflect to the current feature. When you click within any chromatogram or 
spectrum, you can zoom in on the axes of the entire data set to see more of the 
feature detail.

Figure 7 Data areas within the Feature Details pane. The EIC is replaced with the Drift Spectra for IM data.

Figure 8 Data areas within the Feature Details pane for LC/IM-MS data.
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User Interface
Menu bar
When you right-click within any chromatogram or spectrum, you have 
additional commands to print, copy and save the graphical information. 

Menu bar
The following menus are available in Mass Profiler:

• “File menu”

• “Method menu” on page 24

• “View menu” on page 25

• “Identify Features menu” on page 28

• “Web Mass Search menu” on page 30

• “Help menu” on page 31

File menu

Create Project Opens the Create Project dialog box that you use to begin a 
new project. See “Create a project” in the Familiarization Guide.

Open Project Loads a previously saved project into the main window. 
Because Open Project also loads the method used to create the results saved 
in the project, if you have unsaved changes in your current method a dialog 
box prompts you to save your current method before the Open dialog box is 
opened.
20 Mass Profiler Quick Start Guide



User Interface
Menu bar
Note: The data file path is saved with the project. If you move a project to a 
different computer, you can open the project and review the results. 
However, to access the Feature Details (“Feature Details” on page 18), the 
data files on the target computer must be in the same path as on the source 
computer. If they are not, Mass Profiler cannot find the .rmc file, or .c4d file 
(for LC/IM-MS data), that is stored in the data file and an error message is 
displayed. The path where the data files are expected is displayed in the 
error message.

Reprocessing a project with different method parameters also requires that 
the data files are available in the path that is saved with the project.

Edit Project Opens the Edit Project dialog box where you can edit the current 
project. See “Edit a project” in the Familiarization Guide.

Save Project Saves changes to the current project using the Project name 
previously entered in the Create Project dialog box. The default folder is 
\MassHunter\MassProfiler\Projects.

Save Project As Opens the Save Project As dialog box so you can save the 
current project using a different name. You can also specify a different folder 
to save the project.

Export Feature Summary > From Table Opens the Save As dialog box to export 
the feature summary information from the Feature Table for use in a 
spreadsheet. The export file format is tab-separated value (TSV) and can be 
opened in a text editor, but it is saved as an XLS file so that Excel opens the 
file automatically when you double-click the file in Windows Explorer. You can 
export from the Feature Table using one of three commands:

• From Table - All Features

• From Table - Marked Features

• From Table - Unmarked Features

If you have marked features from a principal component analysis a PCA Mark 
column is added to the Feature Table and two additional commands are 
available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features
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User Interface
Menu bar
Export Feature Summary > From Graphed Features The features that meet the 
parameters you select and specify in the Plot mode are displayed in the 
Feature Plot. This command opens the Save As dialog box to export the 
features in the current Feature Plot for use in a spreadsheet. The export file 
format is TSV and can be opened in a text editor, but it is saved as an XLS file 
so that Excel opens the file automatically when you double-click the file in 
Windows Explorer.

Export Target MS/MS Inclusion List > From Table Opens the Export Inclusion 
List Options dialog box where you specify filter parameters for exporting the 
averaged ion data (m/z, z, RT, delta RT) for each feature in the Feature Table 
for use in Data Acquisition in Targeted MS/MS experiments. The export file 
format is CSV. You can export from the Feature Table using one of three 
commands:

• From Table - All Features

• From Table - Marked Features

• From Table - Unmarked Features

If you have marked features from a principal component analysis a PCA 
Mark column is added to the Feature Table and two additional commands 
are available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features

Export Target MS/MS Inclusion List > From Graphed Features 
The features that meet the parameters you select and specify in the Plot mode 
are displayed in the Feature Plot. This command opens the Export Inclusion 
List Options dialog box where you specify filter parameters for exporting the 
averaged ion data (m/z, z, RT, delta RT) for each feature in the Feature Table 
for use in data acquisition in targeted MS/MS experiments. The export file 
format is CSV. 

Export MPP Input File > From Table Opens the Save As dialog box to export 
the feature summary information from the Feature Table for use with MPP. 
The export file format is a tab-delimited text file. You have a choice to export 
with a .txt extension for opening in a text editor, or an .xls extension for direct 
opening in Excel. You can export from the Feature Table using one of three 
commands:

• From Table - All Features
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User Interface
Menu bar
• From Table - Marked Features

• From Table - Unmarked Features

If you have marked features from a principal component analysis a PCA Mark 
column is added to the Feature Table and two additional commands are 
available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features

Export MPP Input File > From Graphed Features The features that meet the 
parameters you select and specify in the Plot mode are displayed in the 
Feature Plot. This command opens the Save As dialog box to export the 
features in the current Feature Plot for use in MPP. The export file format is a 
tab-delimited text file. You have a choice to export with a .txt extension for 
opening in a text editor, or an .xls extension for direct opening in Excel. 

Export Composite-Compounds CEF > From Table... Opens the Save As dialog 
box to export the feature summary information from the Feature Table for use 
with MPP for advanced statistical analysis. The export file format is a CEF file. 
The features within a group are summed to form a composite compound. You 
can export from the Feature Table using one of three commands:

• From Table - All Features

• From Table - Marked Features

• From Table - Unmarked Features

If you have marked features from a principal component analysis a PCA 
Mark column is added to the Feature Table and two additional commands 
are available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features

Export Composite-Compounds CEF > From Graphed Features The features that 
meet the parameters you select and specify in the Plot mode are displayed in 
the Feature Plot. This command opens the Save As dialog box to export the 
features in the current Feature Plot for use with MPP for advanced statistical 
analysis. The export file format is a CEF file. The features within a group are 
summed to form a composite compound.
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Export All Features to CEF  All of the features associated with each sample file 
in the project are exported to a CEF file of the same name as the sample file. 
The CEF files are saved in the Input Data folder.

Exit Closes the Mass Profiler window and exits the program. 

Method menu

Parameters specified in a method define how to extract, align, normalize, 
filter, and compare the features found in your sample data files. When the 
method is run, the results are displayed in the Feature Table and Feature Plot 
in the main window. 

Run Current Method Applies the current method parameters to your project. 
Prior results are replaced and the new results are displayed in the main 
window.

Edit Method Opens the Method Parameters dialog box. When the Commonly 
changed parameters option is clicked (default setting) at the bottom of the 
dialog box, typical parameters are available to review and edit. When the All 
parameters option is clicked, all of the method parameters are edited within 
three tabs: Feature Finding/Loading, Filters, Alignment & Normalization, and 
Statistics & Filters. See “Edit a method” in the Familiarization Guide. When 
you change parameters in a method, the method name in the window title 
indicates an unsaved change using an asterisk (*).

Save Method Saves changes to the current method.

Save Method As Opens the Save Method As dialog box saves the current 
method parameters in the folder you select and using a name you type for the 
File name with the extension .mpm.
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Load and Open Method Opens the Open dialog box. After you select and open 
a saved method the Method Parameters dialog box is automatically opened 
for you to review and edit the method parameters. See “Apply a different 
method” in the Familiarization Guide.

Load Method and Run Opens the Open dialog box. After you select and open a 
saved method the method is automatically applied to your current project. See 
“Apply a different method” in the Familiarization Guide.

Reset Method to Default Immediately restores all method parameters to 
default values. If your method has unsaved changes a Mass Profiler dialog box 
allows you to save your current method or cancel the reset action. The window 
title displays “Method: Default Method.” The following parameters have 
different default values for LC/IM-MS versus LC/MS data files:

• Measure of abundance is Max Ion Volume versus Max Ion Height

• Ion Intensity >= is 100 versus 600

View menu

Switch to Feature-Details Mode If a Feature Plot is displayed in the main 
window, this command is available instead of Switch to Feature-Plot Mode. 
Replaces the Feature Plot pane in the main window with details of the feature 
selected in the Feature Table as shown in Figure 4 on page 15.

Switch to Feature-Plot Mode If Feature Details is displayed in the main 
window, this command is available instead of Switch to Feature-Details 
Mode. Replaces the Feature Details pane in the main window with the Feature 
Plot pane as shown in Figure 3 on page 14.

Feature Details for Selected Feature If a Feature Plot is displayed in the main 
window, a new window labeled Feature-Detail View opens and displays 
details of the feature selected in the Feature Table. If Feature Details is 
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displayed in the main window, the Feature Details information is updated to 
show the details of the feature selected in the Feature Table. See “View results 
in the Feature Details” in the Familiarization Guide. 

Selected Feature in IM-MS Browser Available only if the project contains no 
more than two sample files. Opens one or two IM-MS Browser windows and 
zooms into the RT, DT, m/z space around the feature. With IM-MS Browser you 
can perform interactive browsing and visualization of the data from a single 
LC/IM-MS data file. See “View the feature in IM-MS Browser (LC/IM-MS data)” 
in the Familiarization Guide. 

Abundance Distribution for Selected Feature If the project contains two groups 
and three or more data files, opens the Abundance Distribution of Feature # 
window and displays the abundance profile of the feature and a histogram of 
abundances for the feature within each group. The curves are color-coded for 
each group and are calculated by using the least-squared fit to a Gaussian 
shape. See “View the feature abundance distribution” in the Familiarization 
Guide.

Global Occurrence Histograms Displays histograms that show how frequently 
a feature occurs in samples within each group and across the total set of data 
files. See “View the global occurrence histograms” in the Familiarization 
Guide.
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Principal Component Analysis menu Displays the results of performing a 
mathematical process by which data containing a number of potentially 
correlated variables is transformed into a data set in relation to a smaller 
number of variables called principal components which account for the most 
variability in the data. The result of the data transformation leads to the 
identification of the best explanation of the variance in the data. For a project 
with two groups the objective is to identify whether variations among the 
features separate the samples by group. For a project with a single group the 
analysis can identify samples that may be outliers.

You can export from the Feature Table using one of these commands:

• For All Features in Table

• For Marked Features in Table

• For Unmarked Features in Table

• For Highlighted Features on Graph - The features that meet the 
parameters you select and specify in the Plot mode as displayed in the 
Feature Plot.

If you have marked features from a previous principal component analysis a 
PCA Mark column is added to the Feature Table and two additional 
commands are available:

• From Table - PCA Marked Features

• From Table - PCA Unmarked Features
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Identify Features menu
For each of the menu selections ID Browser is opened with the selected 
feature(s) for identification. See “Identify Features” in the Familiarization 
Guide for more information. 

Note: Identify Features does not apply to data imported from a CSV file or 
from a CEF file with LMFE results.
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For All Features in Table All of the features in the Feature Table are passed to 
ID Browser for identification. The results saved in ID Browser are 
automatically added to the Feature Table after you close the ID Browser 
window.

For Marked Features in Table The features marked in the Mark column in the 
Feature Table are passed to ID Browser for identification. The results saved in 
ID Browser are automatically added to the Feature Table after you close the ID 
Browser window.

For Unmarked Features in Table The features that are not marked in the Mark 
column in the Feature Table are passed to ID Browser for identification. The 
results saved in ID Browser are automatically added to the Feature Table after 
you close the ID Browser window.

For Highlighted Features on Graph The features that meet the parameters you 
select and specify in the Plot mode are displayed in the Feature Plot and are 
passed to ID Browser for identification. The results saved in ID Browser are 
automatically added to the Feature Table after you close the ID Browser 
window.

Identification Lookup for Selected Feature The feature currently selected in the 
Feature Table (the feature with a ►in the row header indicating the table row 
number) is passed to ID Browser for identification. The results viewed in ID 
Browser are not added to the Feature Table after you close the ID Browser 
window. See “Lookup the identity of a single feature” in the Familiarization 
Guide.

If you have marked features from a previous principal component analysis two 
additional commands are available in the Identify Features menu. The PCA 
Mark column is only visible in the Feature Table if compounds have been 
marked in the PCA window.
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For PCA Marked Features in Table The features marked in the PCA Mark 
column in the Feature Table are passed to ID Browser for identification. The 
results saved in ID Browser are automatically added to the Feature Table after 
you close the ID Browser window.

For PCA Unmarked Features in Table The features that are not marked in the 
PCA Mark column in the Feature Table are passed to ID Browser for 
identification. The results saved in ID Browser are automatically added to the 
Feature Table after you close the ID Browser window.

Web Mass Search menu
Performs a mass search via one of several popular online structure databases 
for the feature currently selected in the Feature Plot or Feature Table. The 
results are displayed in your Internet browser window.

ChemIDplus Mass search is directed to the NIH U.S. National Library of 
Medicine TOXNET toxicology data network at 
https://chem.nlm.nih.gov/chemidplus/.

HMP Mass search is directed to the Human Metabolome Project (HMP) 
Human Metabolome Database at 
http://www.hmdb.ca/structures/search/metabolites/mass.
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NIST Mass search is directed to the NIST Chemistry WebBook at 
http://webbook.nist.gov/chemistry/mw-ser.html.

PubChem Mass search is directed to the National Center for Biotechnology 
Information (NCBI) at 
http://www.ncbi.nlm.nih.gov/pccompound?TabCmd=Limits.

Web METLIN Mass search is directed to the Scripps Center for Metabolomics 
METLIN metabolite and tandem MS data base at 
http://metlin.scripps.edu/metabo_advanced.php.

Help menu

Contents Opens the online help window for Mass Profiler with the Contents 
tab displayed.

About Displays the version information for Mass Profiler.
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The following toolbar buttons are available in Mass Profiler. 



Button Equivalent Command

File > Create Project

File > Open Project

File > Save Project

Method > Load and Open Method

Method > Edit Method

Method > Save Method

Identify Features > For All Features in Table

Method > Run Current Method
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The Feature Table (see Figure 3 on page 14) 
shows the results of processing the sample 
files selected in your project with the current 
method. Features are automatically displayed 
when you run the current method and when 
you open a project that has been previously 
processed. The table can be sorted by the 
values in any column by clicking on the 
corresponding column heading.

The following main headings and actions are presented:

• “Feature summary”

• “Experiment <Group 1> and Control <Group 2>” on page 35

• “Comparison” on page 36

• “Table shortcut menu” on page 36

Feature summary
Unless otherwise noted, the values reported for each column are the average 
of the feature across all of the samples.

(Row Number) The leftmost column, without a column heading, contains the 
row number for the features. The row number order does not change when the 
features are sorted by any of the data columns. A right-click in this column 
brings up the shortcut menu shown in Figure 9 on page 45.

ID An identification (ID) number is assigned to each feature based in 
descending order of the values in the Abundance column. The Feature Table is 
initially sorted by the ID value, and therefore by composite feature abundance, 
but the sort order can be changed by clicking on the heading of any other 
column.

Name If you have identified features with ID Browser this additional column 
appears (see “Identify Features” in the Familiarization Guide).

Formula If you have identified features with ID Browser this additional 
column appears (see “Identify Features” in the Familiarization Guide).
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CAS If you have identified features with ID Browser and the compound ID 
includes CAS numbers, this additional column appears.

RT Average retention time of the feature

(RT) SD Standard deviation of the retention time of the feature

DT ion mobility drift time of the feature (LC/IM-MS data)

(DT) SD Standard deviation of the ion mobility drift time (LC/IM-MS data)

Mass Average mass of the feature (non-IM data)

(Mass) SD Standard deviation of the average mass of the feature (non-IM 
data)

m/z Mass to charge ratio of a single adducted species of the feature 
(LC/IM-MS data)

(m/z) SD Standard deviation of the mass to charge ratio (LC/IM-MS data)

Abundance Average abundance of the feature across all of the samples for in 
a single group. For a project with two groups the abundance value reported in 
the Feature Summary is the average across all of the samples in the group with 
the larger average abundance. The value reported can be Max ion intensity, 
Max ion volume, or Feature volume depending on the setting in Measure of 
abundance.

RSD Relative standard deviation of the abundance of the feature (more than 
one sample in a group)

Z Number of charges for the ion (LC/IM-MS data)

Freq. The number of samples that contain this feature

Q-Score The Quality Score is an algorithmic estimate of how likely the 
feature is an actual compound. Q-Score filtering provides an advantage over 
abundance filtering when the features have small abundances.
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Sat. Feature abundance saturation is indicated in this column. Saturation is 
an indication that the relative abundance of the feature with respect to other 
features or between groups may not be reliable and the mass of the feature 
could be slightly shifted.

Mark The check boxes in this column are used to Mark one or more features 
of interest to your project. The mark annotation is exported along with the 
other data in the table, so that the feature can still be distinguished when 
viewed in other programs. If you select a feature in error, click the check box 
again to clear the mark.

PCA Mark If you have marked features from a principal component analysis 
this additional column appears. You can only mark and clear features in this 
column from within the Principal Component Analysis dialog box, click one 
of the commands in the View > Principal Component Analysis menu (see 
“Perform a PCA analysis” in the Familiarization Guide).

Experiment <Group 1> and Control <Group 2>
The values reported for each column are averages for the feature across the 
samples within the individual group only.

RT Average retention time of the feature

DT Average ion mobility drift time of the feature (LC/IM-MS data)

Mass Average mass of the feature

m/z Average mass to charge ratio of a single adducted species of the feature 
(LC/IM-MS data)

Abundance Average abundance of the feature

RSD Relative standard deviation of the abundance of the feature

Freq. The number of samples that contain this feature
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Comparison
The values reported for each column are calculated between the average 
values of RT, DT (for LC/IM-MS data), mass or m/z, and abundance in <Group 
1> and in <Group 2>.

RT The difference in the retention time of the feature between the groups 
(<Group 1> - <Group 2>)

DT The difference in the ion mobility drift time of the feature between the 
groups (<Group 1> - <Group 2>) (for LC/IM-MS data)

Mass The difference in the mass of the feature between the groups (<Group 
1> - <Group 2>)

m/z The difference in the mass to charge ratio of a single adducted species of 
the feature (for LC/IM-MS data)

log2(A1/A2) The log base 2 of the ratio of the average feature abundance 
where A1 = <Group 1> and A2 = <Group 2>

Expression Indication of whether the average abundance of the feature in 
<Group 1> is greater (up) or lower (down) with respect to the average 
abundance of the feature in <Group 2>. When the equation log2(A1/A2) is 
greater than 0, the expression is reported as up-regulated. When the equation 
log2(A1/A2) is less than or equal to 0, the expression is reported 
down-regulated.

Diff. Score The differential score is a value between 0 and 100 that represents 
whether the data groups are significantly different. The score is calculated 
using the Student’s t-test. A larger value indicates a higher confidence that the 
data sets in the two groups are different.

Table shortcut menu
See “Feature Table shortcut menu” on page 45 for commands when you 
right-click on the leading cell of a feature row.
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Feature Plot
The Feature Plot pane shows a graphical 
result of processing the project with the 
current method. By adjusting the parameters 
you can adjust the plot to visualize the feature 
differences by sample and group. The Feature 
Plot is displayed automatically when you 
open a project or run a method. The relative 
size of the plot markers representing a feature 
is an indication of the average abundance of 
the feature, or abundance in individual 
samples: the larger the marker, the more 
abundant the feature.

The following sections and actions are 
presented:

• “Feature selection”

• “Sample selection” on page 38

• “X-Y selection” on page 38

• “Colored by” on page 39

• “Highlighting criterion and Highlighting threshold” on page 39

• “Plot axes” on page 40

• “Plot mouse actions” on page 40

• “Plot shortcut commands” on page 40

Feature selection
Select the features in the project to process and display in the Feature Plot.

All features All of the features are displayed based on the selection, color, 
and highlighting criteria.

Unique to Experiment <Group 1> The features only associated with <Group 1> 
are displayed based on the selection, color, and highlighting criteria. This 
feature selection is not available for a project with a single group.
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Unique to Control <Group 2> The features only associated with <Group 2> are 
displayed based on the selection, color, and highlighting criteria. This feature 
selection is not available for a project with a single group.

Fully identified Only the features that have been identified with both formula 
and name are displayed based on the selection, color, and highlighting criteria. 
This option is only available when features with both formula and name are 
present in the table.

Sample selection
When All features or Fully identified is selected for the Feature selection, you 
can select from Group avg., Composite, All samples, or any individual sample 
file. Group avg. is not available for a project with a single group.

When Unique to <Group 1> or Unique to <Group 2> is selected for the 
Feature selection you can select from Composite, All samples, or any 
individual sample file.

Group avg. The plot displays comparison and differences of the features that 
meet X-Y selection and the Highlighting criterion for all of the samples using 
monochrome markers.

Composite The plot displays the average values of the features that meet X-Y 
selection and the Highlighting criterion for all of the samples using 
monochrome markers.

All samples The plot displays the average abundance of the features specified 
by the Graph data, highlighted by the Colored by and that meet the 
Highlighting criterion using color markers.

Individual sample The plot displays the average abundance of the features 
specified by the Graph data, highlighted by the Colored by and that meet the 
Highlighting criterion using color. markers.

X-Y selection
When Group avg. is selected for the Sample selection, you can select from 
Abundance comparison, Mass difference, and RT difference for LC/MS data. 
For LC/IM-MS data you can select from Abundance comparison, DT difference, 
m/z difference, and RT difference. Group avg. is not available for a project with 
a single group.
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When Composite is selected for the Sample selection, you can select from 
Abundance vs mass, Abundance vs RT, and Mass vs RT for LC/MS data. For 
LC/IM-MS data you can select from Abundance vs DT, Abundance vs m/z, 
Abundance vs RT, DT vs m/z, DT vs RT, and m/z vs RT.

When All samples or an individual sample is selected for the Sample 
selection, you can select from Abundance comparison, Mass difference, RT 
difference, Abundance vs mass, Abundance vs RT, and Mass vs RT for 
LC/MS data. For LC/IM-MS data you can select from Abundance comparison, 
DT difference, m/z difference, RT difference, Abundance vs DT, Abundance 
vs m/z, Abundance vs RT, DT vs m/z, DT vs RT, and m/z vs RT.

Colored by

None Color is not used in the Feature Plot.

Feature Adjusts the plot so each feature is represented by a different color. 
When more features exist than can be plotted in different colors, features in 
the same area of the plot are plotted in different colors to help you distinguish 
the features.

Sample Adjusts the plot so features in the same sample are represented by 
the same color.

Group Adjusts the plot so features in the same group are represented by the 
same color: red represents <Group 1> and blue represents <Group 2>.

Highlighting criterion and Highlighting threshold
Allows you to filter the features based on criteria, whose threshold value 
determines which features appear as solid color markers in the plot. Features 
that have values below the threshold value are plotted as white markers and 
the features that have values above the threshold value are solid markers.

None All of the features are plotted using solid markers.

Q score Display features with a quality score, an algorithmic estimate of how 
likely the feature is an actual compound, above a specified threshold using 
solid markers.
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Group frequency Display features that are present at or above the specified 
percentage in one group of samples using solid markers.

Differential score Display features with a differential score, a value between 0 
and 100 that represents whether the feature is significantly different between 
the two groups, above the specified threshold using solid markers. Available in 
a project with more than two samples.

Max abundance-RSD Display features whose abundance relative standard 
deviation, within a group, is greater than or equal to the specified threshold 
using solid markers. Available in a project with more than two samples.

Plot axes
Some of the plots axes use mathematical expressions as defined below.

Abundance vs  Plot of the Log base 2 (Log2) of the ratio of the average feature 
abundance versus the selected parameter (DT, mass, m/z, RT).

Abundance comparison Plot of the Log2 of the average abundance of a feature: 

• When Group avg. is selected for the Sample selection, the plot axes are Log2 
of the average abundance in <Group 1> versus Log2 of the average 
abundance in <Group 2>.

• When an Individual sample is selected for the Sample selection, the plot 
axes are Log2 of the feature abundance in the single sample versus Log2 of 
the average abundance of the feature.

Plot mouse actions

Zoom: Click and drag the pointer within the graph to define an area to enlarge. 
The area expands when you release the mouse button.

Marker information: Pass the pointer over a feature to view information about 
that feature.

Plot shortcut commands
See “Feature Plot shortcut menu” on page 46 for commands when you 
right-click a plot.
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Feature Details
The Feature Details (see Figure 4 on page 15) 
shows the details of the feature selected when 
you double-click the row number of a feature 
in the Feature Table. The data presented in 
Feature Details is organized in four panes: a 
table of the feature appearance in each 
sample data file, a table of the feature ions in 
the selected sample data file, and, if available 
for the imported data type, extracted ion 
chromatograms and spectra of the feature for 
each sample data file.

Information available in the Feature Details is 
limited for file types other than raw data files. 
For CEF files extracted ion chromatograms 
are not available. For CSV files only the Feature by all samples pane is 
available.

The following sections and actions are presented:

• “Feature details by sample”

• “Feature details by ion” on page 42

• “Extracted Ion Chromatograms (LC/MS data)” on page 43

• “Drift Spectra (LC/IM-MS data)” on page 44

• “Feature Details shortcut actions” on page 45

Feature details by sample

The information in this table is for the feature selected in the “Feature Table” 
on page 33.

Samples that are part of the Experiment group or <Group 1> are shown in a 
red color. Samples that are part of the Control group or <Group 2> are shown 
in a blue color.

(Row Number) The leftmost column, without a column heading, contains the 
row number for the features. The row number order does not change when the 
features are sorted by any of the data columns.
Mass Profiler Quick Start Guide 41



User Interface
Feature Details
Smpl ID An identification (ID) number is assigned to each sample in the 
project ascending alphabetical order of the file name. The Feature Table is 
initially sorted by the Smpl ID value, but the sort order can be changed by 
clicking on the heading of any other column.

Sample Name The file name of the sample data file

RT Retention time of the feature in the sample file

Mass Mass of the feature in the sample file

DT ion mobility drift time of the feature (LC/IM-MS data)

m/z Mass to charge ratio of a single adducted species of the feature 
(LC/IM-MS data)

Abundance Abundance of the feature in the sample file. The abundance for 
the respective ion species is reported as either Max ion intensity, Max ion 
volume, or Feature volume depending on the method setting for Measure of 
abundance.

Q-Score Quality score of the feature in the sample file. The quality score is an 
algorithmic estimate of how likely the feature is an actual compound. Q-Score 
filtering provides an advantage over abundance filtering when the features 
have small abundances.

# Peaks The number of ions associated with the feature in each sample. The 
number of ions is also annotated in the chromatogram titles for LC/MS data 
after selecting Feature Details for a new feature in the Feature Table.

Feature details by ion
The information in this table is for the feature selected in the “Feature Table” 
on page 33, and for the sample selected in the Feature Details by Sample 
table above. This information is not available for the CSV file type.

The top row functions as a header row and reports the calculated neutral 
mass of the feature, the maximum ion intensity in the Intensity column, and 
the feature volume in the Volume column. The header row is shown in a red 
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color if the values for the ions are from a sample in the Experiment group. The 
header row is shown in a blue color if the values for the ions are from a sample 
in the Control group.

For LC/MS data the table has the following columns:

Species The different molecular ion species associated with the feature in 
the selected sample file.

m/z The mass to charge ratio for each ion species.

Mass The neutral mass calculated for the feature based on the associated ion 
species.

Intensity Reports the Max ion intensity in the header row, otherwise the ion 
intensity.

Volume Reports the Feature volume in the header row, otherwise the ion 
volume.

For LC/IM-MS data the table has the following columns:

RT Average retention time of the feature

DT ion mobility drift time of the feature

m/z Mass to charge ratio of a single adducted species of the feature

Intensity Reports the ion intensity.

Volume Reports the ion volume.

Q-Score Quality score of the ion in the sample file.

Extracted Ion Chromatograms (LC/MS data)
This information is not available for CEF and CSV file types. For LC/IM-MS 
data the extracted ion chromatogram is replaced with drift spectra.
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Double-clicking any row number in the Feature Details by Sample updates 
the Feature Details by Ion. By default all chromatograms are extracted using 
all ions associated with the selected feature. The number of ions is annotated 
in the chromatogram titles.

Double-clicking any row number in the Feature Details by Ion table updates 
the EICs to extract only the selected ion species and annotate its m/z value in 
the chromatogram titles.

The height of the chromatographic peak for all ions of a feature is similar, but 
not identical, to the sum of the intensity values of the individual ions. The 
y-axis does not change when changing the Measure of abundance setting in 
the method.

The gray line represents the EIC of the selected ions across the entire 
retention time range, the magenta colored line represents the elution profile of 
the feature as determined by MFE.

When you click within any chromatogram, you can zoom in on the axes of the 
entire data set to see more of the feature detail. You can click the zoom out and 
y-axis scale buttons to further adjust the zoom factor on all of the 
chromatograms.

Drift Spectra (LC/IM-MS data)
The left pane shows a single drift spectrum at the RT and m/z with the 
maximum ion intensity for the largest evidence ion. The height of the drift 
spectrum peak corresponds to the intensity for the largest evidence ion 
reported in the Feature Details by Ion table.

Mass Spectra
The right pane shows the averaged raw centroid mass spectra across the 
common elution time range for the selected feature in all samples. The ions 
associated for the selected feature in each sample is marked by a red dot. The 
y-position of the red dot corresponds to the volume of the largest evidence ion. 
The absolute height of the signals in the spectrum is arbitrarily scaled so they 
are slightly higher than the indicating dot. However, the relative difference of 
signals within a spectrum, or between spectra of the different samples, is 
maintained. When you click within any spectrum you can zoom in on the axes 
of the entire data set to see more of the feature detail. You can click on the 
zoom out and y-axis scale buttons to further adjust the zoom factor on all of 
the spectra.
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Mass Spectra (LC/IM-MS data)
The right pane shows a single profile mass spectrum at the RT and DT with the 
maximum ion intensity for the largest evidence ion. The height of the mass 
spectrum peaks corresponds to values in the Intensity column in the Feature 
Details by Ion table.

Feature Details shortcut actions
See “Feature Details shortcut menu” on page 47 for commands when you 
right-click within a chromatogram or spectrum.

Shortcut menu commands
Shortcut menus provide commands (Figure 9 on page 45) applicable to the 
context where you click and to your current view. The following shortcut 
menus are presented:

• “Feature Table shortcut menu” on page 45

• “Feature Plot shortcut menu” on page 46

• “Feature Details shortcut menu” on page 47

Figure 9 Some of the shortcut menu commands available within the main window 

Feature Table shortcut menu
Available when you right-click along the left-most row column in the Feature 
Table. The shortcut menu is shown in Figure 9 on page 45.

Feature PlotFeature Table

Feature Details
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Feature Details Opens the Feature-Detail View dialog box in which you can 
review the feature details by sample and by ion, the extracted ion 
chromatogram, and the mass spectrum for the feature as it appears in each 
sample file if the Feature Plot is currently shown in the lower part of the main 
window. If the Feature Details are shown in the lower part of the window, the 
information is updated with the data from the selected feature.

View Feature in IM-MS Browser Available only if the project contains not 
more than two sample files. Opens one or two IM-MS Browser windows and 
zooms into the m/z, RT, DT space around the feature. With IM-MS Browser you 
can perform interactive browsing and visualization of the data from a single 
LC/IM-MS data file.

Abundance Distribution If the project contains two groups and at least three 
data files, opens the Abundance Distribution of Feature # window and 
displays the abundance profile of the feature and a histogram of abundances 
for the feature within each group.

Identification Lookup Opens ID Browser with the selected feature for 
identification. Identification results are not be returned to the feature table.

Web Mass Search Opens your default Internet browser and performs a web 
search for the selected feature to propose an identification based on the 
feature mass. The available web search commands are ChemIDplus, HMP 
(Human Metabolite Project), NIST, PubChem, and Web METLIN.

Feature Plot shortcut menu
These commands are available when you right-click the Feature Plot change 
with whether your pointer is inside the graph region or along the plot border 
that contains the mass axes and plot title. The shortcut menus are shown in 
Figure 9 on page 45.

Unzoom Restores the previous zoom level of the Feature Plot.

Autoscale Resets the axes of the Feature Plot to show all of the features.

Print Image Prints the current Feature Plot image based on your current 
printer settings.
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User Interface
Shortcut menu commands
Copy Image to Clipboard Copies the current Feature Plot image to the 
Clipboard to paste into other applications as either an Enhanced Meta file (a 
group of objects that form the image) or a Bitmap format (a single image 
object).

Save Image to File Saves the current Feature Plot image as either an 
Enhanced Meta file (.emf) or Bitmap (.jpg or .tif) format.

Feature Details Opens the Feature-Detail View dialog box in which you can 
review the feature details by sample and by ion, the extracted ion 
chromatogram, and the mass spectrum for the feature as it appears in each 
sample file.

Abundance Distribution If the project contains two groups and at least three 
data files, opens the Abundance Distribution of Feature # dialog box and 
displays the abundance profile of the feature and a histogram of abundances 
for the feature within each group.

Identification Lookup Opens ID Browser with the selected feature for 
identification. Identification results are not returned to the feature table.

Web Mass Search Opens your default Internet browser and performs a web 
search for the selected feature to propose an identification based on the 
feature mass. The available web search commands are ChemIDplus, HMP 
(Human Metabolite Project), NIST, PubChem, and Web METLIN.

Feature Details shortcut menu
If available for the imported file type in your project, menu commands are 
available when you right-click the extracted ion chromatogram, drift 
spectrum, or mass spectrum plot. The shortcut menus are shown in Figure 9 
on page 45.

Print Image Prints the current Feature Plot image based on your current 
printer settings.

Copy Image to Clipboard Copies the current Feature Plot image to the 
Clipboard to paste into other applications as either an Enhanced Meta file (a 
group of objects that form the image) or a Bitmap format (a single image 
object).
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User Interface
Shortcut menu commands
Save Image to File Saves the current Feature Plot image as either an 
Enhanced Meta file (.emf) or Bitmap (.jpg or .tif) format.

For LC/IM-MS data files, the following two commands are available when you 
right-click the to the left of each sample row. This allows you to sequentially 
open up to four IM-MS Browser windows which automatically zoom into the 
m/z, RT, DT space around the selected feature. When you try to open a fifth 
IM-MS Browser window, a message asks you to first close one of the four open 
IM-MS Browser windows.

View Feature in IM-MS Browser Available if the feature selected in the main 
feature table was detected in the selected sample.

View Data in IM-MS Browser Available if the feature selected in the main 
feature table was not detected in the selected sample.
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User Interface
Unsaved parameter changes
Unsaved parameter changes
When you make a change to your method in Mass Profiler, the software 
automatically places an asterisk “*” after the method name in the Mass 
Profiler title bar as shown in Figure 10 on page 49. The asterisk indication 
helps you remember that the changes you have made to the method have not 
been saved to a method file on disk.

Methods are saved as follows:

1 You can save the method parameters as an .mpm file. Saving a method 
file is optional.

2 Method parameters used to process or reprocess a project are 
automatically saved when you save the project. The method parameters 
are embedded with the project. When a project is reloaded, the 
parameters used to obtain the saved results are loaded into memory and 
the method name displayed is the name of the project, without an 
asterisk.

3 When you exit Mass Profiler, the current method parameters are 
automatically saved internally and reloaded the next time Mass Profiler 
is launched, regardless of whether the method parameters are changed 
or unchanged.

Figure 10 Indication of unsaved changes in your method is by the appearance of an as-
terisk in the title bar.
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Mass Profiler Installation
Unsaved parameter changes
Mass Profiler Installation
1 Install Mass Profiler on the highest performing computer you have available 

to reduce the time it takes to extract and view the features in your sample 
files. Mass Profiler requires a computer running Windows 7 (64-bit) with at 
least 8GB of RAM.

Note: For better processing performance choose a higher frequency CPU 
over a larger number of cores. A solid-state hard drive or RAID which 
includes stripped disks, such as RAID 1 or 10, can improve performance 
specifically when extracting features on multiple data files. Depending on 
the size of a project, and the number of features extracted per data file, 
additional RAM reduces processing time by minimizing the use of the page 
files during the process and is recommended for processing LC/IM-MS data.

2 If an earlier version of Mass Profiler is already installed on your computer, 
remove the earlier version of the software before installing Mass Profiler 
B.08.00. Figure 11 shows the Software Setup dialog box that is displayed 
when a prior version of Mass Profiler is already installed.

Figure 11 Software Setup dialog box indicating Mass Profiler is already installed.

3 Click Uninstall to remove the prior installation of Mass Profiler, and then 
rerun the installation program (MPSetup.exe).
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